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As you read the manual, you will see two icons:

This "Advice" icon gives you tips on using the software 
effectively.

This "warning" icon lets you know about very important things 
which you should pay special attention to. It often calls attention 
to common mistakes which some of our users make; we hope 
you'll avoid them!



Chapter 1: Software Installation & Program 
Overview
Software Installation
To install The Athlete's Diary on your hard disk, first insert the diskette with The Athlete's 
Diary into your PC. Double-click on the Install.exe  program. Follow the on-screen 
instructions given to you by The Athlete's Diary Installer program; explanations are provided at 
each step of the process.

To start The Athlete's Diary, double-click on its icon, select it from the Start Menu (if you 
chose during the installation process to have it added to the Start Menu), or double-click on any of 
the icons for any log (if you chose during the installation process to configure your system so that 
".DAT" files automatically are known to be Athlete's Diary logs). If you open the program itself 
(rather than a log), the first time you'll be asked to either start a new log or open an existing one. If 
this is your first experience with The Athlete's Diary, you might want to open one of the sample 
logs first and "play around with it" before starting your own log by selecting New  from the File 
menu.

Palm Software Installation
If you are also installing and using the Palm version of The Athlete's Diary, you can install it at at 
the same time by running the separate Install.exe  program that accompanies the Palm software. 
This program will not only install The Athlete's Diary software itself into your handheld unit, but 
will also install the conduit which transfers information between the desktop and Palm versions of 
The Athlete's Diary.

If you are using both versions, there are several possibilities:

1. You have been using the Palm version of the software and are now starting 
to use the Windows version. In this case, the first thing you should do is to upload the 
entire contents of your log from your Palm to your desktop, and rename that file to become 
your standard desktop log. Uploading the log is accomplished by temporarily setting the 
conduit to "Handheld overwrites desktop", as described in Chapter 10 of this manual.

2. You have been using the Windows version, and are now starting to use the 
Palm version. In this case, you'll want to start by downloading your log from the 
desktop into the Palm, as described in Chapter 10.

3. You are starting fresh with both versions. In this case, we recommend first starting 
your new log on the desktop, since data entry is obviously accomplished more quickly and 
easily on the desktop. After you configure your log by entering your sports and 
preferences, and after you have entered as many past workouts as you want to, then 
download the desktop log into your Palm, as described in Chapter 10. Now you can use 
both versions simultaneously.



Program Overview

The Initial Screen

When the program starts, you'll see a screen like the one above.The Athlete's Diary consists of a 
series of "tabs" which activate the different functions of the software, along with a series of menus.

Data Entry, which is the default view displayed when the program starts, includes a series 
of fields (date, sport, category, distance, time, pace, route/workout, and comment) into 
which you enter data, and also displays on the bottom a smaller screen of your most recent 
entries, which allows you to see where you "left off" when you open the program to enter 
new workouts.
Log displays your complete log in a scrolling list.
Day displays one workout at a time in full-screen view.
Week displays either one- or four-week views of your log.
Totals displays weekly, monthly, or yearly totals of your workouts in numeric format.
Graph  displays various aspects of your data in graphical format.
Select allows you to select portions of your workout via various criteria, so that the other 
tabs (Log, Day, Week, Totals, and Graph) will display only those portions of your log 
rather than the complete log.

To switch between the various views, simply click on the corresponding tab.



The menus in the program provide access to functions which are typically used less often:

File allows you to start new logs, open existing ones, save data, and print information 
from your log.
Edit  is used to cut, copy, and paste text into the various editable fields, primarily on the 
Data Entry screen.
Select allows you one-step access to some of the functions that are also found on the 
Select tab screen.
Special provides access to certain special functions. A Configure sub-menu allows you 
to configure various aspects of the program, while a Palm sub-menu configures the 
interaction with the Palm version of the software, if you are using that.
Help tells you what version of the software you are using, and is also used to enter your 
serial number to license your software.



Chapter 2: Setting Up Your Log

Starting a New Log
Select New  under the File menu to start a new log. When you do, you will be asked to set up your 
preferences and sports (see next two sections). If you have a log open at the time you create a new 
log, you will be asked if you want to retain your existing sports, preferences, etc. If the log was your 
own log, most likely you'll want to answer "Yes"; if you had one of the sample logs open, you 
should probably answer "No" so that you can make your own choices "from scratch."

Setting Your Preferences

The Athlete's Diary offers you a number of customization options, which you will be asked to 
set up whenever you start a new log. These preferences are saved with your log, and can be changed 
at any time by selecting User Preferences under the Configure sub-menu of the Special menu. 
To set preferences, just click on the desired choices, and then click on the OK button.

Configuring Preferences

The options you have are these:

Response to Close/Quit With Unsaved Changes: If you modify your data, and 
then attempt to either close the file or exit the program, there are two possibilities. Selecting 
Automatic Save (Autosave) will automatically save your data; Request Confirmation 
will show a dialog window that allows you to choose whether or not to save the data.

Make Automatic Backup Copy of Log: Whenever you make changes to the log and 
save the new copy (either automatically or manually), if Automatic Backup is selected 
the previously saved version of your log is renamed XXX.BAK (where XXX.DAT is the 
name of your regular log). Automatic backup provides an extra level of protection. For 
example, if you accidentally delete an entry from your log, your backup copy is unaffected 
If you have your own automatic backup system, such as software which copies new or 
modified files to tape every night, the automatic backup feature within The Athlete's 
Diary is probably not needed; otherwise, we strongly suggest that you leave this feature 
enabled. Logs are fairly small (<100K); having two copies on your disk will not take up 
significant room.



Distance Conversion to Standard Units: When you enter distances in units other 
than your preferred units (see next section), those distances can be immediately converted to 
the preferred units (e.g., 10K becomes 6.2M) if you select On Data Entry. If you select 
Summaries Only, distances are entered in your log as you enter them, and implicitly 
converted when the distances are totalled.

Date Format: There are two date formats: American-style, with month first (3/21/95), 
and the rest-of-the-world-style, with day first (21/3/95). This preference cannot be 
changed after there are entries in the log.

Start Week On: Weeks can start on Monday, Saturday, or Sunday. This affects the way 
data are grouped into weeks for totals, and also the way entries in your log are divided by 
weeks for display and printing.

Setting Up Your Sports

The Athlete's Diary allows you to track up to eight different sports or fitness activities, each with 
its own units of distance and pace, as well as a unique one-letter abbreviation. When you start a new 
log, you will be asked to set up your Sports List. This list is saved and can be modified at any time 
by selecting Sports under the Configure sub-menu of the File menu.

Configuring Sports

The name of the sport, the abbreviation, and the pace units are irrevocable choices you cannot change 
them once you have started a log. Because of this, be sure to give thought to your choices when you 
start your log.

The first time you run the program, the Sports List box at the lower right of the screen will be empty; 
as you add sports it will fill up with your information.

Select a sport from the scrolling list provided, or simply type in the name of any other sport not on 
the list, or if you just want to use a different name (Biking instead of Cycling, for example). The 
program will choose an abbreviation for you, which will be used in entering and identifying that 
sport. You can change it if you want to. No two sports can have the same abbreviation, so if you 
select both Weights and Walking, for example, one of them must be represented by a letter other than 



W.

Next, select a unit of measurement for the distances for that sport miles, kilometers, yards, meters, 
and Units/None. Units/None is provided for activities like Aerobics in which no distances are 
involved, or for sports in which you wish to record the distance in other units, like stairs climbed, 
calories burned, weight lifted, etc. You should also select Units/None for sports with multiple 
distances like duathlon and triathlon.

Finally, select pace units in which your speed for that sport will be calculated. Your choices are 
minutes per mile, minutes per kilometer, miles per hour, km per hour, or None (for non-distance 
activities).

After you have made your selections for a sport, click on the Add  button to add it to your list - don't 
forget this step! Up to eight sports can be added to your Sports List in this way. When you are done 
adding sports, click on the Done button. If you make a mistake while entering a sport, click on the 
name of the sport in the Sports List box, and then click on the Delete button (and then re-enter it 
correctly, if thats what you want).

Once a sport is entered, you can set the color for the that sport which will be used for display 
purposes on the Week and Graph  screens. Select the sport by tapping on it on the Sports List 
screen, then tap the Set Color button.

If you participate in a number of sports only occasionally, you 
might want to select Misc (Miscellaneous) as one of your sports. 
This will enable you to keep track of your one weekend a year 
cross-country skiing, or an occasional basketball game, without 
requiring separate totals for each of these sports. The usual units 
for Misc is None, since the only common denominator for the 
various sports is time.



Chapter 3: Entering Your Workouts

Entering Your Workouts
The Data Entry window presents you with a series of fields into which information is entered. The 
Athlete's Diary provides you a place to record the date, sport, category (training, intervals, or 
race), distance, time, and pace of your workout, along with a description of the route or workout, 
and a comment as well. If there is anything else you want to keep track of your weight or your heart 
rate, for example you can do so in the comment field using the Keyword feature, which you'll read 
about in the next chapter.

Data Entry Window

Use the Tab key to move between fields (or use the mouse to click on each field into which you 
want to enter data). You can also use Shift-Tab (hold down the Shift key while pressing Tab) to 
move backwards from field to field. When you have filled in the desired fields, click on the Save 
button (or press the Enter key); the entry will be added to the log.



It is not necessary to fill in all fields for every entry; only the date 
must be filled in. If you are sick, for example, you might just put 
"Weak from the flu" in the comment, and enter that.

Here are the details about entering information in the various fields:

Date: The date must be entered in the form 3/21/02 or 21/3/02, depending on the format 
you selected in the Preferences window. You can enter dates simply by typing (e.g., 
"3/21/02"), by tapping the down arrow to the right of the field to activate a standard 
Windows "date selector" from which you select the date, or by moving from month to day 
to year (or day to month to year) by using the left and right arrow keys on your keyboard, 
and then either typing numbers for that part of the date, or using the up and down arrow 
keys on your keyboard to increment or decrement that part of the date.

Sport: You can either enter a single letter (your chosen abbreviation) or select the sport 
from the pop-up menu. If you enter a single letter, either lower-case or upper-case will do. 
You cannot enter a sport not in your list, but you can leave the Sport blank if you want to 
make an entry without a sport (like a rest day). If there is only one sport in your Sports List, 
that sport is automatically filled in, but you can delete it.

Category: You can either enter a single letter (T, I, or R for Training, Intervals, or Race) 
or select the Category from the pop-up menu. If you enter a single letter, either lower-case 
or upper-case will do. The Category selections are not "editable" - there are only the three 
choices.

Distance: Enter a number for the distance, and select the units (if they are other than your 
"standard" units for that sport from the drop-down menu to the right of the distance field. If 
your conversion preference is On Data Entry, your entry is converted to your preferred 
units once you add this entry to your log.

For sports for which Units/None has been selected as the units, you can enter anything you 
like in the distance column, or leave it blank. If you enter a number, you will be able to total 
and graph the sum of the values you enter, which might represent weight lifted, stairs 
climbed, calories consumed, or any other numerical value you want to use to measure a 
particular activity. In other cases, you might want to enter letters, like OD for Olympic 
Distance triathlon, or HIM for Half Ironman.

The distance can be marked as an estimate by preceding it with the approximate sign, ~, 
e.g., ~10.4M . Estimates are treated normally for the purpose of calculating totals.

If you don't know the distance, you don't need to estimate it 
yourself. Instead, enter your time and estimated pace, and the 
program will come back and fill in the distance for you (marked 
with an ~ since it will be an estimate). Most people can estimate 
their own pace much better than they can estimate distances.

The program will not let you enter a distance unless you have entered a sport.

Time: Entered in the form Hours:Minutes:Seconds, e.g., 1:03:43, or Minutes:Seconds, 
e.g., 42:17. Times greater than one hour but less than 100 minutes can also be entered 
simply as minutes, e.g., 63:43. 1:03 means one minute, three seconds, and not one hour, 



three minutes. Using the approximate sign ~ makes this an estimated time, e.g., ~34:30.

Entering colons ( : ) in the time is optional. A 3- or 4-digit number is assumed to be 
Minutes:Seconds (e.g., 2325  becomes 23:25 after you press Tab), while a 5- or 6-digit 
number is assumed to be Hours:Minutes:Seconds. If you enter a 1- or 2-digit number, the 
program assumes this is a number of minutes, not seconds. In other words, enter 15  and 
after you press Tab the value will read 15:00.

Fractions of seconds (tenths and hundredths) can be entered, either with or without colons, 
e.g., 4512.3  or 45:12.3 , 537.18  or 5:37.18 .

Pace: Normally, you will not enter a value into the Pace (speed) column; rather, the 
program will calculate it in for you after you have entered your sport, distance, and time. It 
is possible, however, to reverse the process. If you exercise over an unknown distance, 
enter a time and an estimated pace, and the program will calculate the approximate distance. 
If you exercise for a known distance but don't have an accurate time, just enter the distance 
and an estimated pace, and the program will calculate the approximate time.

The program knows that if you are entering pace it must be an estimate, so don't put a ~ 
when you enter it. The program will place a ~ in front of the data it has estimated (time or 
distance).

If you enter a pace, it must be in the relevant format. If the pace for that sport is a speed 
(miles per hour or kilometers per hour), the entry will look like a simple number, e.g., 
21.3 . If the pace is in minutes per mile or kilometer, pace must be entered in the time 
format, e.g., 7:45 (again, you can leave out the colon if you wish).

Some people prefer to enter just the time for their workouts, even 
for sports like running. This is permissable, but your totals and 
averages will be more useful if you enter a pace estimate and let the 
program calculate your estimated distance. Most people can easily 
estimate their pace to within 15%, and isn't that better than no 
estimate at all?

The program will not let you enter a pace unless you have entered a sport.

Route/Workout: This is a free-form entry where you can describe the route you took, the 
workout you did, or the name of the race you participated in.

The Athlete's Diary will memorize up to twenty of your common workouts not only the 
route/workout description, but also the sport, distance, category, and any other fields that 
you wish to memorize.



Once a workout is memorized (described below in Chapter 4), you can enter that workout 
quickly and easily using the Autofill pop-up menu located just below the Route/Workout 
label. First enter the date, then select the workout from the pop-up menu. Now click the 
mouse down on Autofill popup and a pop-up list of the memorized routes will appear, as 
shown above. Select the desired workout from the list. The memorized information is filled 
in, and the cursor moves to the first blank field (most often the Time). Enter the time, 
modify other fields (like the Comment) as appropriate, and click on Save.

Using memorized workouts to enter data in your log is just a 
starting point. If today's workout varied in some way, feel free to 
change the appropriate part of the entry.

Comment: A free-form entry where you can describe the weather, your feelings, who you 
ran with, or anything else. The Comment can also be used to track other numeric quantities, 
such as weight, resting heart rate, etc. This is done using Keywords, which you'll read 
about in the next chapter.

To enter large amounts of information in either the Route/Workout or Comment fields, 
simply keep typing; the field will auto-wrap and auto-scroll. You cannot use the Enter 
(Return) key to insert a new line; both fields are essentially one long, continuous line of 
text.

Use the small scroll bars at the right edge of each field if you need to scroll backwards or 
forwards to view or edit the contents of that field. The limit to both fields is 511 characters, 
or 255 characters if you want to maintain compatibility with the Palm version of the 
software.

As you enter the Route/Workout and Comment, bear in mind that 
these fields can be used for selecting entries (Chapter 6). For 
example if your dog's name is Nicky and you always enter with 
Nicky in the comment when you run with him, you'll be able to 
look at all the runs you've done with him, and even total up his 
mileage as well as your own! Try to be consistent. In this example, 
if you wrote with the dog in the comment one day, that run 
wouldnt be included in Nicky's totals.



Note that, although the Route/Workout and Comment fields can 
contain more text than can fit on a single line, they are still effectively 
"single-line" fields, that is, you cannot have a "new line" in the 
middle of your route/workout or comment entry. Pressing the Enter 
(Return) key is the same as clicking on the Save button, that is, it 
adds the current entry into your log.

Saving Your Log
If you have selected Automatic Save as a preference, your log is automatically saved when you 
select Exit from the File menu. If you haven't selected Autosave, when you Exit you'll be asked if 
you want to save the changes you have made; click on Save if you do. You can also select Save in 
the File menu at any time to update your current file.

If, like many people, you start using The Athlete's Diary by 
entering many months' worth of data from your written log, you 
should save your work frequently don't leave yourself at the mercy 
of a computer crash!

Quick and Easy Daily Entry
Here is a step-by-step example of data entry:

1. Double-click on your log which will start the program and have it bring up your log.
2. Assuming you are entering data on the day of the activity, the date will be correct, so press 

Tab.
3. Type in the code letter for the sport (e.g., r for Running) and press Tab. Using lower-case 

will save you the step of using the Shift key.
4. Assuming the category is Training, press Tab again.
5. Type in the distance, and unless it was in units other than your normal ones, omit the letter. 

Thus if you ran 3.5 miles, type 3.5  and press Tab.
6. Type in the time (e.g., 2720) and press Tab. The pace will be automatically calculated.
7. Type in the route, then press Tab, then your comment, then click Save (or press Enter) to 

add the entry to your log.
8. Tap on the "Close Box" (the "X" in the upper right hand corner of the window) to exit from 

the program (or press Ctrl+Q for quit) and (assuming you have Autosave turned on) save 
your data automatically (if you don't use Autosave you'll have to click on Save when 
asked).

If you have done one of your memorized workouts, the process is even easier:

1. Double-click on your log which will start the program and have it bring up your log.
2. Select the workout from the Autofill pop-up menu.
3. Type in the time (e.g., 2720) and press Tab twice.
4. Type in the comment, then click Save (or press Enter) to add the entry to your log.
5. Tap on the "Close Box" (the "X" in the upper right hand corner of the window) to exit from 

the program (or press Ctrl+Q for quit). Thats it!



Chapter 4: Data Entry - Special Topics
Memorized (AutoFill) Workouts
It is the rare athlete who doesn't repeat certain workouts. The Athlete's Diary allows you to 
memorize up to twenty of your most common workouts, and then lets you enter those workouts into 
the log with a single menu choice. you'll see later that you can also display or graph just those 
workouts with a single menu selection.

A memorized workout consists of the route or workout description itself, as well as the sport, 
distance, category, and any other fields that you wish to memorize.

To memorize a workout, fill in the Data Entry window as if you were making a normal entry (don't 
worry about the date; it will be ignored). When you have entered the information that you want to 
memorize, select Memorize Info from the bottom of the Autofill popup menu. A dialog box will 
appear. Enter the name you want to give to this workout, then click on the OK button to add the 
workout to your list (or click on Cancel if you change your mind).

Many people confuse the name of the workout with the contents of 
the Route/Workout field, or with the memorized workout itself. The 
name of the workout appears in the popup menu, and should be kept 
short. The contents of the Route/Workout field is a full description 
(as long as 255 characters). And the memorized (Autofill) workout 
itself contains not only the Route/Workout description, but typically 
the sport, category, and distance.

Memorized (Autofill) workouts, like Preferences and Sports, are stored with the log. This means that 
different logs (i.e., different people or different years) can have different memorized workouts.

To delete a memorized workout: : when you select the route from the Route/Workout pop-up menu, 
hold down the Delete key as you release the mouse. You will be given a chance to change your 
mind. Deleting a memorized workout does not affect any entries in the log which used that workout. 
You can't modify an Autofill workout; instead, simply delete it as just described and then re-enter it, 
correctly.

Memorized workouts appear in the menu in the order in which you create them, so its a good idea to 
enter your most popular workouts first, so they will appear at the top of the menu.

Keywords
The standard numerical information entered and tracked in The Athlete's Diary is time, distance, 
and pace. But there are other things you may wish to keep track of in your log your weight, your 
resting heart rate, the time you spend in your target heart zone, and so on. The Athlete's Diary 



uses Keywords to let you track this kind of information in the Comment field of your log.

A Keyword is simply an abbreviation that you pick (like Wt to track your weight), and then use to 
enter numerical information as part of the comment field, e.g., Ran well today. Wt=164. Once 
you do this, the Keyword information can be extracted, totalled, and graphed by the program.

To memorize a Keyword, select Add New from the Keyword pop-up menu which appears below 
the Comment label:

Adding a Keyword

This screen will appear:

Enter the Keyword (without an equals sign) in the Keyword abbreviation box, and then enter a more 
descriptive label which will be used to label your graphs of this quantity. For weight, for example, 
the Keyword abbreviation might be "Wt", while the Keyword label might be "Weight in pounds" or 
"Weight (lbs)".

Now select between the three types of Keywordsd. An averaged Keyword is something like weight. 
If you enter it twice a week in your log, you don't want to see the total (!), you want to see the 
average of those two entries. A totalled Keyword might be something like ascent, where you are 
keeping track of how much climbing you do on your bicycle (or on foot). Here, of course, you do 
want to add entries together, just like totals of distance or time, rather than average them. A 
non-numeric Keyword is one you will be using simply for selection. For example, you can set the 
enter the name of a particular pair of running shoes as a keyword, so that later on it will be easy to 
select only workouts done with those shoes to total mileage on that pair.

Click on OK, and your Keyword will be memorized.

To delete a Keyword, select it from the Keyword pop-up menu in the Data Entry window, but hold 
the Delete key on the keyboard down as you release the mouse (you will be given a chance to 
change your mind!). As with Autofill workouts, this will delete the Keyword from the menu, but it 



will not affect any of the data in your log.

Entering Keyword Data

Keyword values are entered into the Comment field. Enter the Keyword, being sure to always use 
the same spelling, followed by an equals sign (=), followed by the Keyword value. don't use spaces 
around the equals sign.

More than one Keyword can be entered in the same comment. For example, your comment might 
read: Great workout. Wt=165, RHR=42.

You can enter the Keyword simply by typing it in, but the recommended method is to simply use the 
Keyword popup menu; this automatically adds the keyword (and an equals sign for averaged or 
totalled keywords) so that you won't have to remember the abbreviation you are using.The Keyword 
is added at the current insertion point; it does not replace the entire comment.

The numbers you enter with your Keywords can be simple numbers (like 160), times (like 34:50), 
or percentages (like 75%). You might use a time Keyword to track the time you spent in your target 
heart zone, or to track particular splits of your workouts. If you have a hill climb that is part of a 
regular bike route, for example, you might enter Hill climb=41:30 in your comment each time you 
do that route. Now you'll be able to graph the average time per week it takes you to do the hill climb.

When you use a percentage keyword, the entry is treated as the percentage of the time found in the 
Time field. If you spend 75% of a particular workout in your target heart zone, for example, you 
might enter THZ=75% in your comment field. If you do this for every workout, you'll then be able 
to graph time per week or month of exercise in the target heart zone.

Keywords are stored with the log. This means that different logs (i.e., different people or different 
years) can have different keywords.

Weight Training and Exercise Machines
Weight training and exercise machines are not ideally characterized by time, distance, and pace. 
Nevertheless, The Athlete's Diary can easily be used to keep track of these activities. How you 
do so depends on what you want to keep track of, and what kind of calculations that you want to do 
(if any).

If you set the distance units for the activity to Units/None when you set up your Sports List, you can 
total or graph any number you put in the distance field. You might want to keep track of the total 
weight you lift, or the number of sets times the number of reps per set, for example.

You may also want to use the Keyword feature described in the previous section to track various 
numerical aspects of your training with weights or machines.

If you work with different kinds of machines, or different kinds of weights, there are two ways to 
keep them separate:

Create separate sports for each activity, e.g., Stairclimbing, Rowing, NordicTrack, or abs, 
lats, etc.

Put all the different activities into a single sport, but note in the Route/Workout field which 
machine or which muscle group you were working. This will enable you to select out all the 
workouts of a particular type (selection is described in Chapter 6).



Interval Workouts
Swim sets, track workouts, etc., can't be described by a single pace. Perhaps you run 440s with a 
warm-up/cool-down and jogging between intervals. There are four ways to enter workouts like this:

Make two entries in the log, one for the fast part of the workout, and another for the rest.
Make a single entry for the total workout, and just accept the fact that the pace displayed is 
an average pace for the whole workout and not a real pace.
Make a separate entry in the log for each set or interval.

If you use one of the first two methods (the first is probably the most commonly used), then you can 
record times for each set or interval in the Comment field. The program won't do any calculations on 
those splits, but you have a record of your splits, which is probably the main thing you want.

Multi-sport Events
Multi-sport events (duathlons, triathlons, etc.) should be entered in a particular manner. First, enter 
the event as a Duathlon (Biathlon) or Triathlon, with your total time for the entire race. For the 
distance you might enter OD for example, for Olympic Distance, or HIM for Half-Ironman (or just 
leave it blank). You can also enter the distance in the Route/Workout field, where you have more 
room. This entry is for informational purposes only; neither the time nor the distance(s) which are 
part of this log entry will be included in your totals.

In order to calculate your pace for the individual segments of the race, and also to have your time and 
distances included in your totals, you now add a second, third, and possibly fourth entry into the 
log, one for each segment, with the individual sport entered as appropriate for that segment. Of 
course if you didnt get exact splits for this race, you'll have to use estimates. Use the Comment field 
to record your transition times.

Equipment Use
The comment field is used to track equipment use, in two different ways. The first applies to 
equipment which is changed, and then remains in use. An example would be a new bike tire, or a 
new pair of running shoes for a person who only wears one pair at a time. In this situation, the first 
time you start using the new equipment, just enter a phrase in your comment field like "New front 
tire" or "New Adidas" or something like that.

The second type of equipment use applies to situations where you are alternating equipment with 
each workout. The typical example of this is people who alternate between two or three pairs of 
running shoes. For this type of equipment use, you'll need to enter something in the comment field 
for each workout, like "Asics#1" or "Asics#2" to show which pair of shoes was worn for that 
workout. To expedite this, and to make sure you enter the abbreviation consistently each time, you 
should create a "non-numeric keyword" (see above) containing that abbreviation. Now you can just 
select the appropriate keyword from the popup list to enter it for each workout. When you retire that 
pair of shoes, you can simply delete it from the keyword list.

In Chapter 6, you'll read about how to use the information you have entered in order to total up your 
equipment use.



Chapter 5: Displaying Your Log
The Log (List View)
The Log window provides a columnar list of all your workouts. Alternating weeks are displayed 
using alternating white and light-gray background. Races appear in red.

The Daily Log

Like a written log, entries always appear in chronological order. If you add a new entry which is out 
of place, it is automatically sorted into the correct position. When the log is first opened, the scroll 
bar is positioned so that the most recent entries (usually the ones of most interest) are shown. To 
scroll the log, use the scroll bar in the usual way.

When the Log window is the active window, double-clicking on any entry in the log brings up the 
Day view, displaying that entry in full detail. Clicking and holding the mouse down on any entry in 
the Log causes a pop-up menu to appear on the screen, with four choices View, Modify, and 
Duplicate, with the following results:

View does the same thing as double-clicking on the entry, i.e., displays that entry in the 
Day window.
Modify copies that entry to the Data Entry window, where it can be modified.
Duplicate also copies that entry to the Data Entry window, but changes the date to the 
current default date. Making changes and entering that data leaves the original entry 



unchanged.

At the bottom of the Data Entry screen, the Recent Entries list always contains your last 10 
entries. This mechanism described above works there too, that is, if you click and hold the mouse on 
any entry, you'll be able to View, Modify, or Duplicate that entry without having to go to the 
Log screen.

Day View
The Log window shows many entries, but some of the information is shown in an abbreviated 
format. To see complete details of a single entry, use the Day window. You can turn the pages of the 
journal forward or backward one entry at a time by clicking on the left and right arrows in the 
display.

Daily Journal

Buttons at the bottom of the window let you Modify, Duplicate, or Delete the displayed entry. 
Modify and Duplicate function like the same items in the popup menu on the Log screen; Delete 
is the only way to delete an entry from your log (you will be asked to confirm your selection if you 
choose this).

Week View
A calendar is a familiar way to look at your workouts. It has disadvantages (if you look at a weekly 



calendar, and it's the first day of the week, you don't see much!), but it has the big advantage that it 
provides graphical feedback of certain aspects of your training, how often you're swimming, when 
your last long run was, etc.

The Athlete's Diary provides two different calendars. One shows one week at a time; the other 
shows four weeks (an "athlete's month"). The single week view shows more information for each 
workout, but fewer workouts; the four-week view shows more workouts, but less information per 
workout.

Both views shows totals and the one-week view shows averages as well, along with the workouts 
themselves. Different sports are color-coded to help provide visual feedback.

To change the week (or weeks) viewed, you can either use the left and right arrow buttons to move 
backwards or forwards in your log, or you can enter the date of the desired week (or the first week 
of four) into the date selector in the same way that you enter dates on the Data Entry screen.



Chapter 6: Analyzing Your Training
Examining Totals
The Totals window displays a list of either weekly, monthly, or yearly totals, for each of your 
sports, as well as the totals summed for all sports. The number of times you did a particular sport, 
the total hours and distance, and the average pace are all calculated and displayed. Alternating weeks 
or months are displayed as alternating white and light-gray background. The scroll bar allows you to 
scroll through your list of totals.



How Calculations Are Done

The number of workouts is calculated from only those entries in which 
either the distance or the time is entered Average pace is calculated from 
only those entries in which both distance and time are entered. If you put 
entries in your log with just a time (or just a distance), the time (or 
distance) will be added to the total time (or distance), but will not affect 
the calculation of the average pace.

Totals are calculated using only currently selected log entries (see 
Selecting Entries at the end of this chapter). This allows you to calculate, 
for example, the total mileage you have ridden your bike commuting to 
work, the distance you have run on hot days, etc.

Sports in which the distance units are Units/None are totalled according 
to the numerical values in the Distance field, allowing you to total up 
stairs climbed, calories consumed, or whatever else you wish to 
measure. Average pace is not calculated in this situation.

Totals are not calculated for multisport events including Triathlon, 
Duathlon, or any sport ending in the letters athlon or atlon (which covers 
a number of non-English languages). This is to prevent duplication, 
since the run, bike, and swim legs of those sports were also entered (and 
totalled) separately.

Graphing
The Graph window allows you to display in a graphical format all of the information which is 
displayed in the Totals window. What you see on the graph is controlled by the two pop-up menus at 
the top of the window, as well as the date and time period selections at the bottom of the screen.



The first menu, the graph type menu, controls the content of the graph, and provides standard 
choices of time, distance, pace, #workouts, and calories burned, along with the various "keywords" 
(see above) that you have set up. The second menu controls the sport or sports which are displayed 
in the graph.

The one "tricky" thing about the graph type menu is that distance and pace can only be chosen if you 
first choose a particular sport. In other words, while you can select Time or #workouts or calories 
burned for running or cycling or running and cycling combined, if you want to graph pace (or 
distance), you must first select running (or cycling or anything other than "All Sports") and then 
select pace (or distance).

The time period for the graph is controlled by the popup menu in the lower right, and the starting 
point of the graph is controlled by the date selector in the bottom middle of the screen. As with the 
Week view, you can move forward or backward using the arrow buttons, or just enter the desired 
starting date for the graph using the date selector. Scales for the vertical axis are always automatically 



selected by the program.

All graphs, including keyword graphs, can include data from all your workouts, or from just selected 
entries. For example, you can graph your Average Heart Rate (AHR) for all your workouts, or you 
can select a particular interval workout and see a graph of your AHR during just that workout. you'll 
read more about selection in the next section.

Selecting Entries
Normally, the Log, Totals, Graph, Day, and Week windows display your entire log. If you wish to 
view, print, or analyze just part of your log, you can use the Select screen to select just a portion of 
your log.

The Selection Window

The Selection Criteria window displays each of the fields, with a pop-up menu to its right that 
contains a series of appropriate modifiers for that field. For example, the distance pop-up has Equal 
To, Approximately Equal To, Greater Than, Less Than, and From(/To) choices.

For the distance, time, pace, route, and comment fields, if you select one of the choices from the 
pop-up menu, one or two (as appropriate) data entry fields will appear on the right of the window. 
Click on that field and then enter the desired selection criteria. Note that some fields will not appear at 
first until they are relevant so your screen will not appear exactly like that shown above. For 
example, until you enter a sport, the Pace field will not be displayed, since it isn't appropriate 
without a sport.

The date shows a starting and ending date. When you first display the screen, these will be filled in 
with the earliest and latest dates in your log, in other words, the dates appropriate for selecting your 
entire log. To display only entries after a certain date, just change the starting date to the desired day; 
to display only entries before a certain date, just change the ending date.

The rules for entering values in the fields are similar to making an entry in your log: times don't 
require colons when entered, distances don't require distance units if they are your default units, and 



so on.

When you first use the Select screen (at a time when all entries are "selected"), there will be just two 
buttons on the bottom of the screen - Select and Clear (there is no "Cancel"; if you change your 
mind about wanting to make a selection, just click on another tab to return to another screen). Once 
you make a selection, the selection will be reflected on the top line (the "Title Bar") of the window, 
right after the name of your log. There you will see something like "545/545 entries" (if all entries are 
selected), or "123/545 entries" (if a selection you have made includes 123 of the entries).

If you have made a selection, if you return to the Select screen, you will now see four new buttons. 
Five buttons are now labelled "Select":

Select uses the criteria you have entered and searches the entire log for matches.
Select Fewer only searches through those entries which were already selected by a 
previous selection. This is equivalent to a "logical and" function, that is, the resulting entries 
match criteria set #1 and set #2.
Select More selects entries in addition to those already selected by a previous selection. 
This is equivalent to a "logical or" function, that is, the resulting entries match either criteria 
set #1 or criteria set #2.
Select All selects all entries. The Select menu also includes this identical option, for 
quicker access.
Select Reverse starts with the workouts that were selected by the previous selection, 
"unselects" them, and instead selects all the other workouts (the ones which didn't match 
the entered criteria).

Once you have made a selection, the Log and Week windows can be set to display only the selected 
workouts, or to display all the workouts but with the selected ones highlighted. The second mode 
lets you see your selected workouts in the context of your entire log, so, for example, you can see 
what you did on the days before and after the selected workouts. You do this by choosing either the 
Show Selected Only or Show All, Highight Selected toggle button on the Select window, 
or making the identical choice from the Select menu. The value of this probably won't be obvious to 
you at first, so just try it so you can see the difference between the two "modes."

To quickly return to viewing all your entries without having to return to the Select tab, choose 
Select All from the Select menu, or, equivalently, press Ctrl+A.

Tracking Equipment Use
In Chapter 4 you learned how to enter information in the Comment field in order to track equipment 
use. It is on the Select Criteria window where you then use that information in order to total up the 
usage (distance and time) for that equipment. The two situations discussed there are analyzed 
differently. In situation one, you entered "New front tire" (or something like that) on the day you 
mounted a new front tire on your bike. To find out how many miles you now have on that tire, in the 
Comment popup select Since, and then enter "New front tire" in the comment field, so that the 
screen reads "Comment since new front tire". Now, when you press Select, the software will first 
search your log (from the most recent entry backwards) until it finds the requested phrase. If the 
phrase is found, the date of that workout will be substituted for the start date.

For the second kind of equipment use, like multiple running shoes, you do something different. 
From the Keyword popup menu, select the keyword for that equipment. When you do so, tthe 
keyword abbreviation will be inserted in the Comment field, and the Comment popup will be set 
to Contains. Now when you press Select, all workouts containing that equipment will be selected.

In both cases, when you press Select, you will be taken to the Totals window to see your usage.



Chapter 7: Planning Ahead
Training Plans
People training for marathons, century bike rides, and many athletic events want to follow training 
plans (also known as training programs) which have been developed for that purpose. You can find 
training plans in books, in magazine articles, and now, on computer as well. The Athlete's Diary 
gives you the ability to create your own training plans from scratch, to enter them yourself from 
magazine articles, to create them by duplicating some of your own previous training, or by using a 
training plan obtained from Stevens Creek Software.

The usual disclaimer applies do not embark on any training program 
without the advice of your physician.

Setting up a Training Schedule
You can enter future workouts using the Data Entry window just like actual workouts. Typically, 
you might enter just the planned time, or the planned distance, but not both (although you can). 
Then, when you actually do the workout, simply select that workout to modify (as described above), 
then modify the values as appropriate, and save it back into your log.

Planned vs. Actual Training

Some people like to be able to compare the training they planned, vs. the 
training they actually did. The Athlete's Diary is designed to have 
only a single time, distance, and pace for each entry. Nevertheless, there 
are several different ways you might use the software to track actual 
versus planned:

Keep two logs, one with your planned training, the other with 
your actual, so you can print out graphs and totals from the two 
separately and compare them.
Keep two separate sports, for example, Running and Planned 
Runs.
Just record one sport, and when your actual training deviates 
from your plans, just make a note of that in the comment.

Using a Training Plan from Disk
The Athlete's Diary can also use training plans which are already prepared on disk. To The 
Athlete's Diary, a training plan is similar to a log, but the entries are given relative dates instead of 
actual dates. That is, the last date of the training plan (usually the day of the race on which the plan 
culminates) is given a date of 0, the previous date is called -1, and so on.

To use a training plan, first open your own log (or start a new one). Now use Merge in the File 
menu and select a training plan. The software recognizes that the file you are attempting to merge is a 
training plan, and asks you for the date of the race for which you are training (the last entry in the 



training plan is assumed to be the race; if this is not the case, just enter the date you want the training 
plan to end, rather than a race day). Enter the date, and the training plan will be merged into your log, 
ending on the day of the race.

If the training plan is, say, 112 days long, and the race is only 100 days away, somethings got to 
give! If the software detects such a situation, it will give you three choices forget the whole thing, 
read in only the last 100 days of the training plan, or read in the whole training plan (even though 
you've already missed the first 12 days). Select one of these choices.

Creating Your Own Training Plan
You can create your own training plans in two ways. First, let's say you thought you did just the 
right thing in preparing for last fall's marathon, and you want to reproduce the last 12 weeks of 
training exactly. Open the log containing the relevant training, and use the Select window to select 
out the 12 weeks (or whatever) prior to and including the race. Now choose Save Selected As 
from the File menu, and select the choice which reads Save as Training Program. Now you can 
open this year's log, and merge in that training plan as described above. Of course, as you do the 
training you'll be modifying each entry to reflect your actual training.

The second way to create your own training plan is from scratch. Lets say you read a magazine 
article entitled 60 days to your first century (100-mile bike ride) and want to do that. Start a new log, 
and just enter those 60 days of training, starting the first entry on any day you like (it won't matter at 
all). Some published training plans of this type will include only a distance for each days workout. 
Others will include only a time. Some may include both. All of these methods are perfectly acceptable 
to the software. Now, once you have the training entered, use Save Selected As and choose Save 
as Training Program. Now open your real log, use Merge to read in the training plan, and tell 
the computer what day you'll be doing your century (or marathon or 10K or whatever), and you'll be 
all set. All that's left is to do the training!



Chapter 8: Other Topics
Backing Up Your Log
The Athlete's Diary maintains a very important document the record of hours of your hard work. 
you'll be very upset if you lose this data! The Automatic Backup preference allows you to 
automatically make a copy of your log whenever you save a new copy. This means you'll have two 
files on your disk (one of them will be one day out of date), so you'll have twice as much protection. 
This isn't enough, though.

For maximum safety, at least once a month, and better 
yet once a week, you should copy the log onto a floppy 
disk, and put that floppy disk in another room or even 
another place (like at your place of work) from your 
computer. This protects you against fire, flood, and theft. This 
may seem like unnecessary effort when nothing happens. It won't 
when something does! If you aren't sure how to do this, please 
consult the manuals that came with your computer - this is an aspect 
of using a Windows computer, and one you should be familiar with.

Its also a good idea to make a hard copy on a once/month basis at least. As you start into a new 
month, you might select the previous month using the selection criteria, and then print out only those 
entries, so that all the entries for that month will appear on the same page(s).

Travelling
Going on a trip and don't have a portable computer or the Palm version of The Athlete's Diary? 
Try this. Go to the Week view, select the 1-week view, and Print the log. Now you'll have a blank 
calendar page with nice neat columns or boxes. Jot down your training as you travel, and then enter 
it into your computer when you return.

Printing
The Print item in the File menu will print the log, totals, daily or weekly view, or graph, depending 
on which screen is active when you select Print. The function of the Page Selection portion of the 
Print Dialog box depends on the window. For the Log and Totals windows, All prints the entire (or 
selected portion of) the log; From and To print just the page range indicated. For the Graph and 
Journal windows, All prints just the displayed graph or journal page. To print more than one journal 
page, set the From and To fields in the Print Dialog to the number of the first and last pages that you 
wish to print (the page number of any entry is displayed in the bottom of the Journal, between the 
two arrows).

Both portrait and landscape printing are supported; experiment to find which you prefer for the 
different types of output. Windows which are printed as graphics (the Graph, Day, and Week 
windows) are automatically expanded, holding the aspect ratio constant, to fill as much of the printed 
page as possible.

The Log and Totals windows are printed (and displayed) in a monospaced font, which can be 
changed by selecting Font in the Configure sub-menu of the Special menu. Other windows are 
printed using pre-selected fonts in pre-selected sizes.



Saving your log in HTML format
If you use Save Selected As in the File menu to save your whole log or selected portions of it as 
an HTML file, your log can be viewed by Web browsers such as Netscape, Mosaic, Microsoft 
Internet Explorer, Firefox, Safari, etc.

Just viewing your existing log with a browser gives you one feature not present in The Athlete's 
Diary - your entire Route/Workout and Comment will show in each entry (compared to viewing 
your log in the Daily Log window, where just the first one or two lines are displayed). You can get 
additional functionality by using two features of HTML embedded images and links. Embedded 
images might be race photos, heart rate charts, etc., which you have scanned or otherwise have on 
your computer as either a GIF or a JPG file. To have the picture displayed in your log, simply put 
something like the following in either the Route/Workout or Comment field of an entry in
your log:

<IMG SRC="MyPhoto.gif">

(where MyPhoto.gif is the filename of your photo, and we are assuming that the file is in the same 
folder as your log itself). You'll find that this will only really work well if you keep your pictures 
fairly small.

A link might point to a Web page you have prepared yourself, or simply a text file which might be a 
copy of an e-mail you sent to friends describing one of your races. In the second case, save the file 
with a .TXT extension, and be sure to save it as a simple text file, not in some other format such as 
Microsoft Word. Now in the Route/Workout or Comment field, put something like this:

<A HREF="MYRACE.TXT">Race report</A>

The <A...> and </A> sections should bracket a word or phrase which will become a link to your
race report. The referenced file can also be a photo:

<A HREF="MYPHOTO.JPG">Race photo</A>

You'll probably find that this method of including photos as links (rather than directly as described 
above) will be more suitable for large photos.

Saving Your Settings
The current value of almost all pop-up menus, the size and position of each window that has been 
opened, the current choices for font, are all saved automatically when you exit the program, and are 
recalled each time you run the program.



Chapter 9: Menu Reference
File Menu

New  begins a new log.
Open  opens an existing log.
Merge reads an additional log and merges it into the currently open log. This can be used to 
combine multiple logs, to manually add workouts that were added on a Palm into the 
desktop log (this can also be done automatically as described in the next chapter), or to read 
in training plans.
Revert to Saved will discard any changes you have made since opening the log. It is 
useful if you think you did something irretrievable, such as deleting a workout you didn't 
mean to delete.
Save saves the current log using the current name.
Save Selected As saves either the entire current log (if all entries are selected), or a 
portion of that log (if selection has been used to select just certain workouts) into a separate 
file.When you choose Save Selected As, you'll see a dialog box giving you a number of 
choices:

Save Selected As Dialog Box

Save complete log saves the data as a normal Athlete's Diary log, complete 
with all information about your sports, preferences, routes, and keywords. You 
can use this to save your races in a separate file, for example.
Save entries only saves just your log entries (in our standard tab-delimited 
ASCII format), without the sports, etc. you'll find this useful if you want to export 
some or all of your entries to another program
Append To Existing File is designed to assist in keeping a separate race log. If 
you want to do this, after you have entered your latest race in your regular log, use 
Select to select just that entry. Now select Save Selected As and choose 
Append to Existing File and that single entry will be appended to the end of 
the file you select (such as a lifetime race log). Note: this command will append 
your entry to any text file you select. It does not check to see that the file is actually 
a file created by The Athlete's Diary.
Save as HTML file (Web page) saves the selected log entries in the form of a 
web page (".htm"  extension) which can be viewed by a web browser.
Save As Training Program saves your log with relative dates (dates in which 
the last date is set to 0, the day before that is -1, and so on). Training plans (or 
programs) were described in the previous chapter.

Archive is an option which allows you, when your log is getting too big, to "archive" the 
older entries into a separate log. When you select Archive you'll see this screen



Select a starting and ending date, click OK, and you'll save the chosen entries into a 
separate file. If you check the "Remove archived records" box, then, after those entries are 
saved into a separate file, they will be removed from the current one. The limit to the 
number of entries in one log is 10,000, but you may find that you want to archive old 
entries long before you reach that limit. Previous versions of The Athlete's Diary were 
limited to a maximum of four years' worth of entries in one log; that is no longer a 
limitation.
Print prints the currently active view of the log. From either the Data Entry or the Log 
tabs, it prints the Log. From the Day, Week, Totals, or Graph  tab, it prints the 
corresponding data.
Exit exits the program and, if Autosave is active, automatically saves your log. If Autosave 
is not active, and you haven't chosen Save yourself, you'll be asked if you want to save 
your new entries (if their were any). Pressing Ctrl+Q (for Quit) is the equivalent of 
selecting the Exit menu.
Exit Without Saving lets you exit the program and deliberately, for whatever reason, 
NOT save any changes you have made (perhaps you were just "fooling around" 
demonstrating the program to a friend).

Edit Menu
Undo undoes the last editing operation in an active edit field. It does NOT undo other 
actions, such as saving an entry, deleting an entry, etc.
Cut cuts (removes) the currently selected text from an active edit field.
Copy copies the currently selected text from an active edit field to the "clipboard" from 
where it can be pasted into other fields or other applications.
Paste pastes the current contents of the clipboard into the active edit field.

Select Menu
Select All makes sure that all entries in the log are currently "selected" (and hence 
displayed, totalled, graphed, etc.). Pressing Ctrl+A is the equivalent of selecting the 
Select All menu.
Show Selected Only displays only selected entries on the Log and Week screens.
Show All, Highlight Selected displays all entries on the Log and Week screens, but 
highlights the selected entries in yellow highlight.

Special Menu
Sort Entries sorts the log chronologically. In principal, the log should ALWAYS be 
sorted chronologically, and this should never be needed. However, if anything goes wrong, 
and the log does get "out of order" entries, this can seriously affect the way the software 
displays data on the Week, Totals, and Graph  screens in particular, so this menu is 
provided just in case something does go wrong.
Configure is a sub-menu with four choices:



Preferences lets you change the log preferences (described above).
Sports lets you enter or modify your log's "Sports List"
Calories lets you configure the information used to extract your weight, which is 
used in the calorie calculations on the Graph screen. The following screen is 
displayed:

Configuring Calorie Calculations

To calculate calories burned, you can either enter a fixed weight (in pounds, 
kilograms, or stone) to be used for the calculation, or you can instruct the software 
to use a particular "Keyword" in your log (such as "Wt") to extract the weight 
from your log (which will therefore adjust the calorie calculations for your 
changing weight over the months or years).
Fonts lets you adjust the fonts used for the printing of the Log and Totals screens 
(which must be a "monospaced" font such as Courier), and the fonts used for the 
display and printing of the day and week view screens. You'll see a screen that 
looks like this:

Configuring Fonts

To configure one or another font, tap on the corresponding button along the left 
side of the window.

Log is a sub-menu with two choices:
Make Default Log makes the currently active log your default log. This log is 
the one which is automatically opened if you run The Athlete's Diary program, 
and is also the one, if you are HotSync'ing data from your Palm, into which new 
data entered on the Palm is automatically merged after being uploaded from the 
Palm. You can change the default log at any time, simply by opening any log and 
making it the default log. To deactivate the default log feature (i.e., to make no log 
the default log), you need to start a new log using the File New menu, then 
immediately hit Cancel when asked to name the new log, and then, at a time when 
no log is open, select Make Default Log.
Add to Start Menu adds the currently open log into an Athlete's Diary folder 



in your Start Menu, so that you can open that particular log simply by choosing 
it from the Start Menu.

Palm is a sub-menu with two choices:
Make Palm Upload (Merge) Log makes the currently active log the log into 
which new data entered on the Palm is automatically merged after being uploaded 
from the Palm. Under virtually all foreseeable circumstances, this will be the same 
as the default log, so after using the Make Default Log menu, this menu 
shouldn't be necessary. Only if for some unknown reason you want your Palm 
entries merged into a different log does this become relevant. If so, make sure you 
use Make Palm Upload (Merge) Log after using Make Default Log.You 
can change the Palm merge log at any time, simply by opening any log and making 
it the Palm merge log. To deactivate the merge log feature (i.e., to deactivate 
automatic merging from the Palm), you need to start a new log using the File 
New  menu, then immediately hit Cancel when asked to name the new log, and 
then, at a time when no log is open, select Make Palm Upload (Merge) Log. 
Note: setting the Palm "merge log" in this way is superceded (i.e., non-functional) 
if you have a file named MergeLog.txt in your Palm upload folder. See the 
discussion of "AutoMerge" in the next chapter for more about this.
Set Palm Download Folder lets you select file folder which is used to 
download data into your Palm. Using the example in Chapter 10 below, this 
would be C:\Palm\Nicky\Athlete's Diary. If this folder is configured, then 
all new entries you make into the desktop file are automatically saved into a file 
named Downlaod.dat in the designated folder, from where they are automatically 
HotSync'd into your Palm (assuming you have the Palm conduit set to 
"Synchronize"). This eliminates the necessity of you performing that step 
manually.

Help Menu
About displays the current version of the software, and also provides a place for you to 
enter your serial number (registration number) which fully licenses the software (not 
functional in the beta version, which is fully active regardless of licensing).



Chapter 10: HotSync'ing with Palm
If you have the Palm version of The Athlete's Diary, you'll be interested in HotSync'ing 
information between your desktop copy and the Palm version.

HotSync
If you want to exchange data with the Windows desktop versions of The Athlete's Diary, you'll 
be using the HotSync feature to accomplish one or more of these four functions:

1. Download an entire log from your desktop computer to your handheld unit.
2. Upload an entire log from your handheld unit to your desktop computer.
3. Download new (or modified) entries from your desktop to your handheld.
4. Upload new (or modified) entries from your handheld to your desktop.

We'll discuss each of these functions in turn, but first we'll discuss the one thing they have in 
common - the Athlete's Diary folder in which data must be placed to be downloaded, and in 
which data will appear after being uploaded. This location of this folder and the files it may contain 
will vary from system to system, but a typical setup is shown here, in a case where we are assuming 
that the handheld unit (your Palm) has the name "Nicky" (folder or directory names are shown in 
black, and file names in red):

C:
  Palm
    Nicky
      HotSync.Log
      Athlete's Diary
        Download.dat
        Download.bak
        PalmLog.dat
        PalmLog.bak

You won't need to create any of these folders (shown in black) yourself. When you install your Palm 
(or related, e.g., IBM, Franklin, Symbol, Sony) desktop software, the main directory (shown as 
Palm above but this name may vary on your system) will be created. Whenever you HotSync a 
handheld unit to that desktop computer for the first time, a new sub-folder is then created (shown 
here as Nicky). The folder name may be different than that of your Palm itself if the Palm name 
contains spaces or is longer than 6 letters (for example, it might be "Bullwi" if your Palm name is 
"Bullwinkle", or "SmithT" if your Palm name is "Tom Smith".). And finally, the first time you 
perform a HotSync after installing The Athlete's Diary conduit, the Athlete's Diary folder 
will be automatically created. The only thing you as a user will need to be concerned with are the files 
in that folder (shown in red).

The file HotSync.Log, which is a standard file created by the Palm HotSync software, is an 
important one for two reasons. First, because some people have trouble locating their "user folder" 
(C:\Palm\Nicky in this example). If you do, use the "Find Files" feature of your operating system 
to search for the file HotSync.Log. If you find more than one, open each one in turn (using the 
NotePad application) and read the information in it, which includes the date and time of the last 
HotSync. You should be able to recognize the "active" file by noting which one has the most recent 
date and time. Secondly, the HotSync.Log file is important because everything that happens during 
the HotSync is noted in that file. The Athlete's Diary conduit in particular will write such things 
as "uploaded 2 new entries" into that file. So if something seems to be going wrong with 



HotSync'ing, the very first thing to do is to read the HotSync.Log file and see what it tells you.

Selecting the Conduit Mode

To select the action of the conduit, click the right mouse button on the HotSync Manager and select 
Custom from the HotSync menu. Note: if The Athlete's Diary does not appear on the list of 
conduits, then the conduit is not installed; consult the installation instructions for the Palm version of 
The Athlete's Diary in its manual. You will need to run or re-run the Install.exe program that 
came with your TAD/Palm software in order to activate the conduit.

Assuming The Athlete's Diary does appear, select The Athlete's Diary conduit from the list 
which appears and click on the Change button. A dialog box will appear with the four possible 
choices, allowing you to select the HotSync action for the next HotSync and the default action for all 
other HotSyncs.

Downloading your log from the desktop to the handheld

When you want to install a complete log from your desktop software into your handheld version 
(either when you first start using the Palm version of the software after having already set up a 
desktop log, or perhaps when you're about to leave for a trip, etc.), set the conduit setting to 
Download desktop log to handheld. Now from within the desktop version of The Athlete's 
Diary, select Save Selected As from the File menu, choose Save complete log from the 
choices which are presented, and save the file by the name Download.dat in the Athlete's Diary 
folder. Note that the file must have exactly this name to be recognized by the conduit. When you 
HotSync, any data (including not only workouts but also memorized "AutoFill" workouts, 
keywords, and sports information) will first be deleted from the handheld unit, and then the 
corresponding information contained in the Download.dat file will be written to the handheld unit. 
After the process is complete, the desktop file will be renamed Download.bak to provide an 
indication to you that that data has now been installed into your handheld unit.

A note on non-American-style dates: The Athlete's Diary on the desktop and in the Palm 
support two date styles: Month/Day/Year and Day/Month/Year. In the desktop versions, this setting 
is controlled by a preference setting within the software itself. On the handheld unit, the setting is 
controlled by the Palm's system preferences. When you are downloading data from the desktop to 
the handheld unit using The Athlete's Diary conduit, however, the date style is controlled by the 
system-wide setting in your desktop operating system (the Regional and Language Options Control 
Panel). This means that if you want to download data from your desktop to the handheld unit (using 



either this setting of the conduit, or the Synchronize setting described below, you must have all 
three settings in agreement - desktop operating system setting, the Palm operating system setting, and 
the preference within the desktop version of The Athlete's Diary.

Uploading your log from the handheld to the desktop

If you have been using the Palm version of the software and now are beginning to use the desktop 
version, you'll want to start by uploading the complete log from Palm to desktop. Set the conduit 
setting to Upload handheld log to desktop and perform a HotSync. When you HotSync, all 
data (including workouts, memorized "AutoFill" workouts, keywords, and sports information) is 
written to the desktop to a file named PalmLog.dat in the Athlete's Diary folder. This file is a 
complete log, identical in format to logs which are created by the desktop version of the software, 
and can be immediately opened and used by the desktop software. When these files are created on the 
desktop, any previous version is renamed PalmLog.bak (Windows). Now you can use the File 
Open  menu to open that log from your desktop Athlete's Diary. Next use File Save Selected As 
(selecting Save complete log) to save it into a separate file by a different name, because the 
PalmLog.dat name is a "reserved name" used to upload data from the Palm; it shouldn't be used as 
the name of your log. You can save the log in the special Palm Athlete's Diary folder, or you can 
save it in the folder in which your TADXP software is located; the choice is yours. Now use Open 
from the File menu to open the file you just saved, and then use Make Default Log from the Log 
sub-menu of the Special menu to make this new log your default log.

Downloading new or modified entries from the desktop to the handheld

If you have used the Configure menu to configure the Download folder (see below in the Menu 
Reference section), then all new entries made on the desktop are automatically added to a 
Download.dat file in the correct folder. Alternatively, you can use the Select screen of your desktop 
Athlete's Diary to select just those entries to be downloaded into the Palm, and then use Save 
Selected As in the File menu to save just those workouts as Download.dat in your Athlete's 
Diary folder. Now set the conduit setting to Synchronize, and when you HotSync, the new 
workouts are downloaded to the handheld unit and appended to the existing workouts (and 
automatically sorted into place chronologically).

Uploading new or modified entries from the handheld to the desktop

Set the conduit setting to Synchronize, and when you HotSync, any "dirty" (new or modified) 
entries on the handheld unit are uploaded to the desktop in your Athlete's Diary folder, to a file 
named PalmLog.dat (with previous files being renamed as noted above). These files are not 
"complete" Athlete's Diary logs but contain only new or modified workouts  which have been entered 
on the handheld (changes to sports, keywords, and AutoFill workouts are not included). After the 
data are uploaded, they must be merged into your desktop log. This can happen in one of two ways:

AutoMerge

When the data are uploaded, the conduit checks to see if you have set a desktop 
"merge log" using Make Palm Upload (Merge) Log from the Log sub-menu 
of the Special menu. If you have, the data are immediately merged into that log.

If you have two different Palms (e.g., two members of a family) being HotSync'd 
to the same desktop, and want to merge the data from each Palm into a different 
desktop log, then you need to override the standard mechanism for merging by 
creating a text file named MergeLog.txt in your Athlete's Diary folder (and, 
if you are indeed HotSync'ing two different Palms, then each Palm will have its 
own Athlete's Diaryfolder and can have its own, independent, MergeLog.txt 
file. If such a file exists, the contents of that file are read and interpreted as the 



name of the desktop log file into which the uploaded data will be merged.So for 
example if the file named MergeLog.txt contains a single line of text reading as 
follows: C:\TAD\MyLog.DAT, then after new workouts are uploaded into the 
PalmLog.dat file, they will then be automatically merged into 
C:\TAD\MyLog.DAT. To create this MergeLog.txt file, use a simple text editor 
such as NotePad.

Manual Merge

If you don't want to use the automatic method, or for some reason it doesn't 
appear to be working, you can use the manual method. After performing the 
HotSync, open your desktop log with the desktop version of the software, select 
Merge from the File menu and read in the PalmLog.dat file containing the 
uploaded data. Make sure you do this before the next HotSync, before 
you lose the data in in your Palm Log  file.  If you make a mistake and do 
perform another HotSync before opening your desktop Athlete's Diary and 
using Merge, you'll still be able to Merge the data, but it will now be in the 
renamed file (PalmLog.bak).

And finally, setting the conduit setting to Do nothing...does nothing.
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